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C H A P T E R 2

Resource Manager Essentials 
Applications

This chapter lists all the Essentials applications and their tasks that can be 
accomplished with each of these applications. The applications are:

• Availability

• Change Audit

• Configuration Management

• Contract Connection

• Inventory

• Job Approval

• Software Management

• Syslog Analysis
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Availability
Table 2-1 lists all the applications and the device credentials required for proper 
functioning of the applications.

.

* Required in case of few devices.

Availability
The Availability application lets you monitor the reachability and response time 
of your network devices. You can view the availability of a selected group of 
devices, a summary of interface status, reports of reloads (reboots) and 
unreachable devices, and protocol distribution graphs. 

Table 2-2 shows the tasks you can accomplish with the Availability application.

Table 2-1 Applications and the Device Credentials

Application Telnet Password Enable Password SNMP Read Only SNMP Read / Write

NetConfig Required Required Not required Not required

NetShow Required Required Not required Not required

Config Editor Required Required Not required Not required

ChangeAudit Not required Not required Not required Not required

Configuration 
Management 
(Telnet)

Required Required Required Not required

Configuration 
Management 
(TFTP)

Not required Not required Required Required

Device Views Not required Not required Not required Not required

Inventory Not required Not required Required Not required

SWIM Required * Required * Required Required

Syslog Not required Not required Not required Not required

Availability Required Required Required Not required
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Availability
.
Table 2-2 Availability Manager Tasks

Task Purpose Action

Set polling 
views and 
options.

Select views to be monitored. You must 
do this before you can monitor device 
availability. 

If your system performance is degraded 
by availability polling, you can add more 
CPU, poll fewer devices, or poll less 
frequently. 

Select Resource Manager Essentials > 
Administration > Availability > 
Change Polling Options.

Change polling 
options.

Select default Availability polling option 
values or to select new values from the 
drop-down list boxes. 

The polling options you set, apply to all 
Availability views. 

Select Resource Manager Essentials > 
Administration > Availability > 
Change Polling Options.

View the 
Reachability 
Dashboard.

View device status for all views set for 
availability monitoring. The dashboard 
continuously reports: 

• All views being polled and the 
number of devices in each view. 

• Device names of all devices in each 
view and the time they last 
responded. 

Select Resource Manager Essentials > 
Availability > Reachability Dashboard.

Monitor device 
availability.

Continuously monitor selected devices 
and access interface availability details. 

Select Resource Manager Essentials > 
Availability > Availability Monitor.

View the 
Reloads report.

Display the most recent reloads (up to 5) 
for selected devices. The report shows the 
reason for each reload and when it 
occurred.

Select Resource Manager Essentials > 
Availability > Reloads Report.

To view reloads that occurred only within 
the past 24 hours, select

Resource Manager Essentials > 
24-Hour Reports > Reloads Report.
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Availability
View the Stack 
Decoder 
Analysis.

Decode and analyze a device’s stack 
dump to enable troubleshooting of 
devices that reload unexpectedly.

An unexpected reload is any reload that is 
neither initiated by you nor a result of a 
power-on.

The Reloads report applies only to routers 
running Cisco IOS Release 10.2 or later 
and is available only for the most recent 
reload.

Select Resource Manager Essentials > 
Availability > Reloads Report.

In the generated report, click on the 
unexpected reload.

View the 
Offline Device 
report.

Generate a report of managed devices that 
have not responded to polling for more 
than a specified period of time (3, 6, 12, 
24, 48, or 72 hours). 

Select Resource Manager Essentials > 
Availability > Offline Device Report.

To view only devices that have been off 
line for the past 24 hours, select 
Resource Manager Essentials > 
24-Hour Reports > Offline Device 
Report.

View the 
Protocol 
Distribution 
graph.

View the distribution of TCP/IP, 
AppleTalk, IPX, DECnet, VINES, and 
XNS packets for selected devices in a bar 
or pie chart. This report shows the 
Level-3 protocol packet types that are 
forwarded by the devices. 

Select Resource Manager Essentials > 
Availability > Protocol Distribution 
Graph.

Table 2-2 Availability Manager Tasks (continued)

Task Purpose Action
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Change Audit
Change Audit
The Change Audit application lets you track and report network changes. It 
provides the capability for other Essentials applications to log change information 
to a central repository, called the Change Audit log.

Table 2-3 shows the tasks that you can accomplish with the Change Audit 
application.

Table 2-3 Change Audit Tasks

Task Purpose Action

View Change 
Audit logs.

View the two log tables: Change 
Audit summary and Change Audit 
details.

• Select Resource Manager Essentials > 
24-Hour Reports > Change Audit 
Report.

• Select any report from Resource 
Manager Essentials > Change Audit.

Delete records 
from the log.

Delete or schedule deletion of change 
records from the Change Audit log.

Select Resource Manager Essentials > 
Administration > Change Audit > Delete 
Change History.

Convert change 
records to 
SNMP traps.

Convert some or all change 
notifications into SNMP V1 traps and 
send them to a destination you 
configure.

Select Resource Manager Essentials > 
Administration > Change Audit > 
Administer Trap Generator.

Define an 
exceptions 
period.

Specify a period of time when no 
network changes should occur.

Select Resource Manager Essentials > 
Administration > Change Audit > Define 
Exceptions Summary.

Set up filtering 
options.

Define one or more filter fields to 
filter report data.

Select Resource Manager Essentials > 
Change Audit > Search Change Audit.

View changes 
in an exception 
period.

Generate a report on changes that 
occurred in the network during a 
defined exception.

Select Resource Manager Essentials > 
Change Audit > Exceptions Summary.
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Configuration Management
Configuration Management gives you easy access to the configuration files for all 
file-based or Cisco IOS-based Catalyst switches, FastSwitches, and Cisco routers 
in the Essentials inventory.

After you import devices into your inventory and they become managed, the 
configuration files are collected and stored in the configuration archive. When 
you change the configuration, the archive is alerted and automatically collects the 
latest configuration information.

Before you can use the configuration archive, you must make sure you have 
completed all the necessary setup tasks. For information on these tasks, see 
Installing and Setting Up Resource Manager Essentials.

Table 2-4 shows the archive-specific tasks you can accomplish with the 
Configuration Management application.

View all 
change 
records.

Generate a report that enables you to 
view changed data in the Change 
Audit log.

Select Resource Manager Essentials > 
Change Audit > All Changes.

View a 
summary of 
changes made 
in the last 
24-hours.

Generate a summary of changes 
made in the past 24 hours from 
Change Audit log data. 

Select Resource Manager Essentials > 
24-Hour Reports > Change Audit Report.

Table 2-3 Change Audit Tasks (continued)

Task Purpose Action
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Configuration Management
Table 2-4 Configuration Management Archive-Specific Tasks

Task Purpose Action

Search for 
configuration 
files.

Search for configuration files based on 
device name or text pattern.

• Select Resource Manager 
Essentials > Configuration 
Management > Search Archive by 
Device.

• Select Resource Manager 
Essentials > Configuration 
Management > Search Archive by 
Pattern.

Create, run, 
modify, and 
delete custom 
reports.

Create and run custom reports that gather 
device configuration files from the 
archive for specified devices. 

You can also modify and delete custom 
reports.

Select Resource Manager Essentials > 
Configuration Management > Custom 
Reports.

Compare 
device 
configuration 
files.

Compare configuration files of two 
devices or two versions of a single file.

Compare the starting and current 
configurations of a device.

Compare the current and the most 
recently archived configurations of a 
device.

Select Resource Manager Essentials > 
Configuration Management > 
Compare Configurations.

Find 
out-of-sync 
configurations.

Determine whether a device’s startup and 
running configurations are synchronized. 
The two configurations might differ if 
you change a device configuration after 
the device is booted.

• Select Resource Manager 
Essentials > Configuration 
Management > Startup/Running 
Out of Sync Report

or

• Select Resource Manager 
Essentials > 24 Hour Reports > 
Configuration Sync Report.

Move the 
configuration 
archive.

Move the configuration archive to a new 
location. 

Select Resource Manager Essentials > 
Administration > Configuration 
Management > General Setup, then 
select the Archive Setup tab.
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Configuration Management
Specify criteria 
for purging the 
archive.

Specify when to purge configurations 
from the archive. You can specify two 
criteria:

• Age. Configurations older than the 
specified age are purged.

• Maximum number of versions. The 
oldest configuration is purged when 
the maximum number is reached.

You can also choose not to purge labelled 
files.

Select Resource Manager Essentials > 
Administration > Configuration 
Management > General Setup, then 
select the Archive Setup tab.

Modify 
configuration 
archive 
retrieval.

Modify how and when the configuration 
archive retrieves configurations. 

Select Resource Manager Essentials > 
Administration > Configuration 
Management > General Setup, then 
select the Change Probe Setup tab.

Change the 
protocol order 
used by the 
configuration 
archive. 

Change the order of the protocols the 
configuration archive uses to download 
configurations from devices to the 
archive.

The default order is:

• TFTP (Trivial File Transport 
Protocol)

• Telnet

• RCP (Remote Copy Protocol)

Select Resource Manager Essentials > 
Administration > Configuration 
Management > General Setup, then 
select the Transport Setup tab.

Update the 
configuration 
archive.

Update the archive manually if you make 
a significant change to a device 
configuration and want the archive to 
reflect the changes.

The configuration archive retrieves 
configurations at 12.30 a.m. every Friday 
by default. It also listens to Syslog 
messages and fetches the configuration. 

Select Resource Manager Essentials > 
Configuration Management > Update 
Archive.

Table 2-4 Configuration Management Archive-Specific Tasks (continued)

Task Purpose Action
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Configuration Management
Check the 
archive status.

Check archive status for the latest attempt 
to archive a device configuration (running 
or startup).

Select Resource Manager Essentials > 
Administration > Configuration 
Management > Archive Status.

Configure 
labels.

Select configuration files from different 
managed devices, group them, and label 
them as a set.

You can also view, modify, and remove 
configuration labels.

Select Resource Manager Essentials > 
Administration > Configuration 
Management > Label Configuration.

Import 
configurations 
from 
CiscoWorks.

Import the latest device configurations 
from the CiscoWorks Sybase database 
into the configuration archive.

You can import configurations from 
CiscoWorks versions up to 4.0.

Select Resource Manager Essentials > 
Administration > Configuration 
Management > Import from 
CiscoWorks.

View status of 
configuration 
import.

View the import status and the number of 
devices in each state, after importing 
configurations from CiscoWorks.

Select Resource Manager Essentials > 
Administration > Configuration 
Management > Import from 
CiscoWorks Status.

Use the 
cwconfig 
command at 
the command 
line.

Access the configuration archive to 
update, export, and import configurations 
on devices and in the archive.

For more information about the command 
syntax and parameters, refer to the 
cwconfig man page on UNIX systems, by 
entering:

man -M /opt/CSCOpx/man cwconfig

This command cannot be entered from 
the desktop; use the command line.

Table 2-4 Configuration Management Archive-Specific Tasks (continued)

Task Purpose Action
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Configuration Management
NetConfig Option
Using the NetConfig option, which runs as a separate application in its own 
window, you can make configuration changes to your managed network devices.

NetConfig uses configuration templates to create the configuration commands run 
on devices when a NetConfig job runs. There are three types of configuration 
templates:

• System-defined: Provided with NetConfig, these templates simplify the 
creation of common configuration commands.

• User-defined: Created by system administrators, these templates can contain 
any configuration commands.

• Adhoc: Allows you to add any configuration commands to a NetConfig job 
while you are defining it.

Integrate Cisco 
Netsys 
configurations.

Integrate Netsys configuration files into 
the Essentials configuration archive.

Select Resource Manager Essentials > 
Administration > Configuration 
Management > General Setup, then 
select the Netsys Setup tab.

View Netsys reports after you integrate 
the configuration files created by Netsys 
into the Essentials configuration archive.

Select Resource Manager Essentials > 
Configuration Management >Netsys 
Report.

Locate the 
configuration 
archive shadow 
directory.

Access the configuration archive shadow 
directory, which is an image of the most 
recent configurations gathered by the 
configuration archive. 

The shadow directories cannot be 
accessed from the desktop.

• On Solaris, as root or casuser, enter: 
/var/adm/CSCOpx/files/archive/
shadow

• On Windows NT, as admin, enter:
C:\program files\CSCOpx\files\
archive\shadow

Table 2-4 Configuration Management Archive-Specific Tasks (continued)

Task Purpose Action
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Caution NetConfig does not verify the commands entered in user and adhoc 
templates. These commands are executed on devices exactly as they 
appear in the template. If you enter incorrect configuration 
commands, you could misconfigure or disable the devices on which 
the job runs.

By default, only network administrators have access to configuration templates. 
Network administrators can assign template access privileges to the other system 
users. When you define or edit a job, the configuration templates to which you 
have access privileges appear in the job definition wizard.

Table 2-5 shows the tasks that can be accomplished with the NetConfig option.

Table 2-5 NetConfig Tasks

Task Purpose Action

Define and 
schedule a 
NetConfig job.

Define a NetConfig job to make device 
configuration changes, and schedule it 
to run.

1. Select Resource Manager 
Essentials > Configuration 
Management > NetConfig > Jobs > 
New Job.

or

Click New Job button.

2. Complete the job definition wizard.

Browse and 
edit NetConfig 
jobs.

Browse the NetConfig jobs that are 
registered on the system and edit them 
as necessary.

1. Select Resource Manager 
Essentials > Configuration 
Management > NetConfig > Jobs > 
Job Browser.

or

Click Job Browser button.

2. Select a job record.

3. Click Edit Job, Copy Job, Remove 
Job, Stop Job, or Job Details.
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View a 
NetConfig 
job’s details.

View detailed information about a 
registered NetConfig job. You can also 
edit a job from its detailed view.

1. Select Resource Manager 
Essentials > Configuration 
Management > NetConfig > Jobs > 
Job Browser.

or 

Click Job Browser button.

2. Select a job record.

3. Click Job Details.

4. Click Edit Job, Copy Job, Remove 
Job, Stop Job, or Print.

Launch 
Essentials.

Launch Essentials if it is not already 
running.

Select Resource Manager Essentials > 
Configuration Management > 
NetConfig >Tools > Launch RME.

or

Click Launch RME button.

Create and edit 
user-defined 
configuration 
templates.

Create and edit configuration templates 
that can contain any configuration 
commands.

Select Resource Manager Essentials > 
Configuration Management > 
NetConfig >Admin> Create/Edit User 
Templates.

Assign 
configuration 
template access 
privileges to 
users.

Assign access privileges to the 
system-defined and user templates on 
the system.

Select Resource Manager Essentials > 
Configuration  Management  > 
NetConfig  > Admin > Assign Template 
Users.

Set default 
template 
policies.

Set the default policies for NetConfig 
jobs that are defined.

Select Resource Manager Essentials > 
Configuration  Management  > 
NetConfig > Admin > Set Template 
Policies.

Table 2-5 NetConfig Tasks (continued)

Task Purpose Action
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Configuration Management
Network Show Commands Option
Essentials ships with a set of default network command sets, which you cannot 
edit or delete. 

Table 2-6 shows the tasks you can accomplish with the Network Show Commands 
option.

View online 
help for the 
task you are 
performing.

View the online help for information 
about the task you are performing.

Select Resource Manager Essentials > 
Configuration  Management  > 
NetConfig > Help > Context-Sensitive 
Help.

or

Click Help button.

Use the 
NetConfig 
command to 
make batch 
configuration 
changes.

Define and schedule NetConfig jobs 
from the command line.

Enter the NetConfig command at the 
command line with the appropriate options 
and arguments.

For more information, refer to the online 
help and the netconfig man page.

Table 2-5 NetConfig Tasks (continued)

Task Purpose Action

Table 2-6 Network Show Commands Tasks

Task Purpose Action

Create a 
network show 
command set.

Create, edit, and delete a logical group of 
custom commands for a user or a set of 
users.

Select Resource Manager Essentials > 
Administration > Configuration 
Management > Network Show > Define 
Command Set.

Assign users to 
the network 
show command 
set.

Specify which user or set of users can run 
network show commands.

Select Resource Manager Essentials > 
Administration > Configuration 
Management > Network Show > Assign 
Users.
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Execute a 
network show 
command set 
immediately.

Run network show commands on one or 
more devices.

Select Resource Manager Essentials > 
Configuration Management > Network 
Show Commands > Immediate 
Execution.

Define a batch 
report.

Create a batch report containing 
command sets and remote console 
commands that can be run on a set of 
devices to generate a report.

You can also modify or delete existing 
reports.

Select Resource Manager Essentials > 
Configuration Management > Network 
Show Commands > Batch Reports > 
Define Reports.

Schedule a 
batch report.

Schedule reports in batches and generate 
these batch reports at a specified time.

Select Resource Manager Essentials > 
Configuration Management > Network 
Show Commands > Batch Reports > 
Schedule Reports.

View report 
output.

View the output of a batch report. Select Resource Manager Essentials > 
Configuration Management > Network 
Show Commands > Batch Reports > 
View Report Output.

Browse 
network show 
jobs.

Browse the network show jobs that are 
registered on the system and view job 
details.

You can also edit or delete jobs. 

1. Select Resource Manager 
Essentials > Configuration 
Management > Network Show 
Commands > Batch Reports > Job 
Browser.

2. Select a job record.

3. Click Edit Job, Stop Job, Remove 
Job, Copy Job, or Job Details.

Table 2-6 Network Show Commands Tasks (continued)

Task Purpose Action
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Configuration Management
Config Editor Option
You can edit configuration files stored in the configuration archive and download 
files to devices, using the Config Editor option. This option runs as a separate 
application in its own window.

Table 2-7 shows the tasks you can accomplish with the Config Editor option.

Set job 
policies.

Each network show job has properties 
that define how the job runs. You can 
configure a default policy for these 
properties that apply to all future jobs.

Select Resource Manager Essentials > 
Configuration Management > Network 
Show Commands > Batch Reports > 
Set Job Policies.

Use the 
cwconfig 
netshowbatch 
command. 

Define and schedule reports, comprising 
multiple network show command sets to 
be run against a set of devices.

Enter cwconfig netshowbatch command 
at the command line.

For more information, refer to the online 
help and the cwconfig netshowbatch man 
page.

Table 2-6 Network Show Commands Tasks (continued)

Task Purpose Action

Table 2-7 Config Editor Tasks

Task Purpose Action

Edit 
configuration 
files from the 
archives.

Check out a file from the archive, and edit 
it.

Select Resource Manager Essentials > 
Configuration Management > Config 
Editor > File > Open.

Schedule 
download jobs.

Define and schedule a download job. Select Resource Manager Essentials > 
Configuration Management > Config 
Editor > File > Download.

Print 
configuration 
files.

Print a configuration file. Select Resource Manager Essentials > 
Configuration Management > Config 
Editor > File > Print.
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Configure job 
policies.

Configure a default policy for job 
properties that applies to all future jobs. 
You can also specify if the property can 
be configured by other users.

Select Resource Manager Essentials > 
Configuration Management > Config 
Editor > Edit > Set Job Policies.

Set up editing 
preferences.

Set up your editing preferences.

Config Editor remembers your preferred 
mode even across different invocations of 
the application. After you open a file in a 
specific mode, you can view it only in that 
mode until you unlock it.

Select Resource Manager Essentials > 
Configuration Management > Config 
Editor > Edit > Preferences.

View changes. View the changes to the checked-out file. 
Essentials compares the current file with 
the checked-out version.

Select Resource Manager Essentials > 
Configuration Management > Config 
Editor > Tools > Show Changes Made.

Compare 
versions of the 
configuration 
files.

Compare the current file with any version 
in the configuration archive.

Select Resource Manager Essentials > 
Configuration Management > Config 
Editor > Tools > Compare.

Enter comment 
lines.

Enter comment lines while editing a 
configuration file. 

Select Resource Manager Essentials > 
Configuration Management > Config 
Editor > Tools > Insert Comment Line.

List checked 
out files.

View a list of files checked out by all 
users.

Select Resource Manager Essentials > 
Configuration Management > Config 
Editor > Tools > List Checked Out 
Files.

Table 2-7 Config Editor Tasks (continued)

Task Purpose Action
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Note Do not launch NetConfig and ConfigEditor from the same browser.

Contract Connection
Contract Connection lets you verify which of your Cisco IOS devices are covered 
by a service contract. Contract Connection uses Inventory Manager, Cisco 
Connection Online (CCO), and Contract Agent, Cisco’s internal tracking service, 
to provide the status of your service coverage.

Contract Connection provides details on:

• A list of contracts from the Contract Agent

• Managed Cisco IOS devices from the Essentials package database

To view contract status, however, you must have login privileges to the CCO web 
site and a CCO profile that enables access to the Contract Agent. 

Browse and 
edit Config 
Editor jobs.

Browse the Config Editor jobs that are 
registered on the system and edit them as 
necessary.

1. Select Resource Manager 
Essentials > Configuration 
Management > Config Editor > 
Tools > Job Browser.

2. Select a job record.

3. Click Edit Job, Copy Job, Remove 
Job, Stop Job, or Job Details.

View job 
details.

View detailed information about a 
registered Config Editor job. You can also 
edit a job from its detailed view.

1. Select Resource Manager 
Essentials > Configuration 
Management > Config Editor > 
Tools > Job Browser.

2. Select a job record.

3. Click Job Details.

4. Click Edit Job, Copy Job, Remove 
Job, Stop Job, or Print Job.

Table 2-7 Config Editor Tasks (continued)

Task Purpose Action
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Device Views
Table 2-8 shows the task you can accomplish with the Contract Connection 
application.

Device Views
Several Essentials applications use device views. Creating a view using the 
Device Views application enables you to run reports for specific devices based on 
common attributes or user-defined characteristics.

Table 2-9 shows the tasks that you can accomplish with the Device Views 
application.

Table 2-8 Contract Connection Task

Task Purpose Action

Check the 
status of a 
contract.

Check which of your Cisco IOS managed 
devices are covered by a service contract 
and review contract details.

Select Resource Manager Essentials > 
Contract Connection > Check Contract 
Status.

Table 2-9 Device Views Tasks

Task Purpose Action

Add static 
views.

Create views to monitor a specific group 
of devices in your network inventory. 

Select Resource Manager Essentials > 
Administration > Device Views > Add 
Static Views.

Add dynamic 
views.

Create views to monitor devices with 
common attributes, such as device type. 

Any new managed device added to 
inventory that fits the listed attributes is 
automatically incorporated into the 
dynamic view.

Select Resource Manager Essentials > 
Administration > Device Views > Add 
Dynamic Views.

Change static 
views.

Modify static views. Select Resource Manager Essentials > 
Administration > Device Views > 
Change Static Views.

Delete views. Delete any views you have created. Select Resource Manager Essentials > 
Administration > Device Views > 
Delete Views.
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Inventory
The Inventory application lets you: 

• Import devices from databases or files.

• Export device information to files.

• Add, delete, change, and list devices in your network inventory.

• Schedule polling and collection to update your network inventory.

• Display reports and graphs of your hardware and software inventory and 
create Inventory custom reports.

• Check and change device attributes.

• Display a Year 2000 compliance report.

• Change system-wide configuration for SNMP, SMTP, proxy and rcp settings.

• Allow other network management systems to manipulate Essentials devices.

Table 2-10 shows the tasks you can accomplish with the Inventory application.

Browse 
dynamic views.

Determine which devices belong to the 
dynamic views.

Select Resource Manager Essentials > 
Administration > Device Views> 
Browse Dynamic Views.

Browse device 
membership.

Determine which views a device belongs 
to.

Select Resource Manager Essentials > 
Administration > Device Views > 
Browse Device Membership.

Table 2-9 Device Views Tasks (continued)

Task Purpose Action
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Table 2-10 Inventory Manager Tasks

Task Purpose Action

List managed 
devices.

Determine whether a particular device is 
managed by displaying devices that have 
inventory data.

Select Resource Manager 
Essentials > Administration > 
Inventory > List Devices.

Add devices. Add devices individually by specifying basic 
device information for each.

Select Resource Manager 
Essentials > Administration > 
Inventory > Add Devices. 

Import devices 
from a file.

Import devices in bulk from a comma 
separated values (CSV) file or a device 
integration file (DIF) instead of adding them 
individually.

 Select Resource Manager 
Essentials > Administration > 
Inventory > Import from File.

Import device 
data from a local 
host.

Import device data from a supported network 
management system (NMS) database 
residing on the local host.

Device import supports these NMS 
databases:

• HP OpenView (Windows NT, Solaris, 
and HP-UX only)

• Cisco WAN Manager (Solaris only)

• Tivoli NetView (Windows NT and AIX 
only)

• CiscoWorks (Solaris, HP-UX and AIX 
only)

Select Resource Manager 
Essentials > Administration > 
Inventory > Import from Local 
NMS.
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Import device 
data from a 
remote host.

Import device data from a supported NMS 
database residing on a remote host. 

Device import supports these NMS 
databases:

• CiscoWorks for Switched Internetworks 
(CWSI) 

• HP OpenView 

• Cisco WAN Manager (Solaris only)

• CiscoWorks

• Tivoli NetView (running on remote AIX 
hosts only)

Select Resource Manager 
Essentials > Administration > 
Inventory > Import from Remote 
NMS. 

Check status of 
import from 
local host, 
remote host, or 
file.

Determine whether a device import was 
successful and rectify the import if the 
device remains unmanaged.

Select Resource Manager 
Essentials > Administration > 
Inventory > Import Status.

Delete managed 
devices.

Delete managed devices, including all the 
related device information, that you no 
longer track.

Select Resource Manager 
Essentials > Administration > 
Inventory > Delete Devices. 

View status of 
deleted devices.

View the status of deleted devices and see 
which ones are in a suspended state.

Select Resource Manager 
Essentials > Administration > 
Inventory > Delete Device Status. 

Table 2-10 Inventory Manager Tasks (continued)

Task Purpose Action
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Inventory
Change device 
attributes.

Change these device attributes on selected 
devices:

• SNMP read and write community 
strings

• Telnet passwords

• TACACS usernames and passwords

• Enable TACACS usernames and 
passwords

• Enable secret passwords

• Local usernames and passwords

• User fields

• Device serial numbers

Select Resource Manager 
Essentials > Administration > 
Inventory > Change Device 
Attributes.

Export devices 
to a file.

Export your device and device access 
information to an output file in CSV or DIF 
format.

Select Resource Manager 
Essentials > Administration > 
Inventory > Export to File. 

Create and view 
inventory 
custom reports.

Create a customized report that gathers all or 
any of this information about specified 
devices:

• IP address

• User field

• RAM size

• Flash size

• Port count

• Hardware version

• Card type

• Serial number

• SAA information

Select Resource Manager 
Essentials > Administration > 
Inventory > Custom Reports.

To view a previously-created report, 
select Resource Manager 
Essentials > Inventory > Custom 
Reports.

Table 2-10 Inventory Manager Tasks (continued)

Task Purpose Action
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Define filters for 
change reports.

Define filters that determine what data is 
displayed in your inventory change reports.

Select Resource Manager 
Essentials > Administration > 
Inventory > Inventory Change 
Filter.

Schedule 
inventory 
collection.

Schedule polling and collection to update 
your network inventory.

Select Resource Manager 
Essentials > Administration > 
Inventory > Schedule Collection. 

Run inventory 
collection.

Run inventory collection as a one-time event 
for specific devices. 

Select Resource Manager 
Essentials > Administration > 
Inventory > Update Inventory.

Schedule device 
polling.

Schedule periodic polling of managed 
devices.

Since the poller uses fewer network 
resources, you should schedule inventory 
polling to run more frequently than 
inventory collection. 

Select Resource Manager 
Essentials > Administration > 
Inventory > Inventory Poller.

Run an 
inventory 
24-hour report.

Determine what inventory changes were 
made in the last 24 hours.

Select Resource Manager 
Essentials > 24-Hour Reports > 
Inventory Change Report.

View a hardware 
report.

View user-specified hardware information 
for each device. 

Select Resource Manager 
Essentials > Inventory > Hardware 
Report.

View a software 
report.

View user-specified software information for 
each device.

Select Resource Manager 
Essentials > Inventory > Software 
Report.

View 
information 
about devices.

View detailed hardware, software, chassis, 
and interface information for multiple 
devices. 

Select Resource Manager 
Essentials > Inventory > Detailed 
Device Report.

View a device 
Y2K compliance 
report.

View which managed devices are compliant 
to the year 2000. Compliance is determined 
by device type and software version. 

Select Resource Manager 
Essentials > Inventory > Year 2000 
Report.

Table 2-10 Inventory Manager Tasks (continued)

Task Purpose Action
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Inventory
View device 
information 
within device 
classes.

View a bar chart of the distribution of all 
managed devices among the recognized 
device classes.

Select Resource Manager 
Essentials > Inventory > Hardware 
Summary Graph.

View the 
software 
versions in each 
device class.

View a bar chart of the distribution of the 
major and minor software versions running 
on your selected devices in each device 
class. 

Select Resource Manager 
Essentials > Inventory > Software 
Version Graph.

View device 
information in 
each device 
class.

View a bar chart showing the distribution of 
your selected devices in each device class. 

Select Resource Manager 
Essentials > Inventory > Chassis 
Summary Graph.

View a summary 
of chassis slots.

View the total number of selected devices 
and the number of devices with free slots for 
each device class that supports capacity 
planning. 

Select Resource Manager 
Essentials > Inventory > Chassis 
Slot Summary.

View the chassis 
slot details.

View the total slots, available slots, location, 
and userfield information for each device.

Select Resource Manager 
Essentials > Inventory > Chassis 
Slot Details.

View details on 
multiservice 
ports.

Check the switch multiservice ports, which 
support voice traffic, to make sure the power 
supply is adequate for the number of 
multiservice modules installed in each 
switch.

Select Resource Manager 
Essentials  > Inventory >
MultiService Port Details.

Verify 
community 
strings, 
usernames, and 
passwords.

Ensure that the database used to store the 
community strings and passwords remains 
synchronized with the actual devices.

Detect errors made when devices were added 
or imported.

Select Resource Manager 
Essentials > Administration > 
Inventory > Check Device 
Attributes.

Table 2-10 Inventory Manager Tasks (continued)

Task Purpose Action
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System Configuration
System Configuration lets you configure system-wide information on the 
CiscoWorks2000 server. In this way, you can centrally locate information that is 
used by more than one Essentials application.

Note Network administrators should set this information carefully. If they 
introduce errors, users may not be able to log in.

Table 2-11 shows the tasks that you can accomplish with System Configuration.

View attribute 
check results.

View the results of updated device attributes. Select Resource Manager 
Essentials > Administration > 
Inventory > View Check Results.

View historical 
data.

View all historical data associated with 
scheduled inventory collection. 

It shows the last run, duration, devices 
scanned, and average scan time.

Select Resource Manager 
Essentials > Inventory > Scan 
History.

Table 2-10 Inventory Manager Tasks (continued)

Task Purpose Action

Table 2-11 System Configuration Tasks

Task Purpose Action

Set up a proxy 
URL.

Enable applications to connect to CCO.

If the server access to the outside world is 
controlled through a proxy server, this 
must be configured.

Select Resource Manager Essentials > 
Administration > System 
Configuration, then select the Proxy tab.

Define SNMP 
timeouts and 
retries.

Specifies the time for timeouts and the 
number of retries to use when querying 
devices for inventory collection. 

Select Resource Manager Essentials > 
Administration > System 
Configuration, then select the SNMP 
tab.
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Job Approval
Job Approval is used by other applications to require that a job be approved before 
it can run. Job Approval sends job requests via e-mail to the users on a job’s 
approver list. If none of the approvers approves the job by its scheduled run time, 
or if an approver rejects the job, the job is moved to the rejected state and will not 
run.

When Job Approval is enabled, applications that use it require that the user do the 
following for each job that is scheduled:

• Assign one or more approver lists to the job

• Schedule the job to run in the future, rather than immediately

Table 2-12 shows the tasks that can be accomplished with the Job Approval 
application.

 

Define the 
SMTP server 
name.

Add and modify command-line 
instructions to be run automatically 
whenever Syslog Analysis receives a 
specific message type.

Select Resource Manager Essentials > 
Administration > System 
Configuration, then select the SMTP 
tab.

Define RCP 
usernames.

Specify the username used to authenticate 
RCP transfers between the devices and 
the server for remote operations.

Select Resource Manager Essentials > 
Administration > System 
Configuration, then select the RCP tab.

Table 2-11 System Configuration Tasks (continued)

Task Purpose Action

Table 2-12 Job Approval Tasks

Task Purpose Action

Approve or 
reject jobs.

Approve or reject a job for which you are 
an approver.

Select Resource Manager Essentials > 
Administration > Job Approval > 
Approve or Reject Jobs.

Set up Job 
Approval.

Enable or disable the application. Select Resource Manager Essentials > 
Administration > Job Approval > Edit 
Preferences.
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Software Management
The Software Management application automates the steps associated with 
upgrade planning, scheduling, downloading software images, and monitoring 
your network. 

Table 2-13 shows the tasks you can accomplish with the Software Management 
application.

Create an 
approver list.

Create a new approver list. Select Resource Manager Essentials > 
Administration > Job Approval > 
Create Approver List.

Edit an 
approver list.

Edit an existing approver list. Select Resource Manager Essentials > 
Administration > Job Approval > Edit 
Approver List.

Enable jobs Enable all imported RME jobs. Select Resource Manager Essentials > 
Administration > Job Approval > 
Enable Jobs.

Table 2-12 Job Approval Tasks (continued)

Task Purpose Action

Table 2-13 Software Management Tasks

Task Purpose Action

Set up your 
software 
management 
preferences.

Specify information such as history page 
size, the directory where images are 
stored, the pathname of the user-supplied 
script to run before and after each device 
software upgrade. 

Select Resource Manager Essentials > 
Administration > Software 
Management > Edit Preferences.
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Software Management
Add images to 
the library.

Import images from all Software 
Management-supported devices in your 
network into the software image library.

Select Resource Manager Essentials > 
Software Management > Library > 
Add Images.

Download images from CCO into the 
software image library.

Add images from a device to the software 
image library.

Add images from a filesystem to the 
software image library.

Browse the 
library.

Generate a report of all the images in the 
software image library. 

You can also delete images from the 
image library and edit image attributes.

Select Resource Manager Essentials > 
Software Management > Library > 
Browse Images.

Search the 
library.

Generate a report of a subset of images in 
the software image library, based on 
details such as, device type, image type, 
and version.

You can also delete images from the 
image library and edit image attributes.

Select Resource Manager Essentials > 
Software Management > Library > 
Search for Images.

View a 
synchronization 
report.

Generate a synchronization report to 
determine which Software 
Management-supported devices are 
running software images not in the 
software image library.

Select Resource Manager Essentials > 
Software Management > Library > 
Synchronization Report.

Schedule a 
synchronization 
job.

Specify the date, time, and frequency of a 
synchronization job.

Cancel a scheduled synchronization job.

Select Resource Manager Essentials > 
Administration > Software 
Management > Schedule 
Synchronization Job.

Create approver 
lists.

Specify who can approve the various 
tasks necessary during a software 
upgrade.

Select Resource Manager Essentials > 
Administration > Job Approval > 
Create Approver List.

Table 2-13 Software Management Tasks (continued)

Task Purpose Action
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Software Management
Edit or delete 
approver lists.

Edit and delete the list specifying who 
can approve tasks during a software 
upgrade. 

Select Resource Manager Essentials > 
Administration >Job Approval > Edit 
Approver List.

Schedule image 
upgrade jobs.

Schedule device upgrades with the 
selected images.

Select Resource Manager Essentials > 
Software Management > Distribution > 
Distribute Images.

After you schedule and complete the 
image upgrade job, you can undo the 
upgrade and roll back to the previous 
image. 

Select Resource Manager Essentials > 
Software Management > Job 
Management > Browse Jobs.

Plan an upgrade 
from CCO.

Determine the impact to and prerequisites 
for a new software deployment using 
images that reside in CCO.

Select Resource Manager Essentials > 
Software Management > Distribution > 
CCO Upgrade Analysis.

Plan an upgrade 
from the library.

Determine the impact to and prerequisites 
for a new software deployment using 
images in your software library.

Select Resource Manager Essentials > 
Software Management > Distribution > 
Library Upgrade Analysis.

Review 
scheduled jobs or 
undo an upgrade.

Review, modify, or remove schedule jobs.

You can also retry failed jobs and undo 
completed image upgrade jobs.

Select Resource Manager Essentials > 
Software Management > Job 
Management > Browse Jobs.

View 
consolidated job 
information.

View a report of device upgrade results 
for selected jobs.

Select Resource Manager Essentials > 
Software Management > Job 
Management > Consolidated Job 
Report.

View recent 
software upgrade 
results.

Generate a report summarizing the most 
recent device software upgrade results 
stored in the history database.

Select Resource Manager Essentials > 
24-Hour Reports > Software Upgrade 
Report.

Mail or copy log 
files.

Mail or copy log files if requested to do so 
by Cisco Support after you report 
abnormal Software Management 
behavior.

Delete unnecessary log files after mailing 
or copying them.

Select Resource Manager Essentials > 
Software Management > Job 
Management > Mail or Copy Log File.

Table 2-13 Software Management Tasks (continued)

Task Purpose Action
2-29
Using Resource Manager Essentials

78-11544-02



Chapter 2 Resource Manager Essentials Applications
Software Management
Browse history. Generate a summary of device software 
upgrades stored in the history database.

Select Resource Manager Essentials > 
Software Management > History > 
Browse History.

Search history by 
device.

Generate a summary of software 
upgrades for selected devices.

Select Resource Manager Essentials > 
Software Management >History > 
Search History by Device.

Search history by 
user.

Generate a summary of software 
upgrades performed by a particular user.

Select Resource Manager Essentials > 
Software Management > History > 
Search History by User.

Browse bugs. Compare images running on software 
management supported devices in your 
network with the images on CCO and 
report catastrophic and severe bugs 
specific to your network. 

Identify devices running deferred 
software images.

Select Resource Manager Essentials > 
Software Management > Bug Reports > 
Browse Bugs.

Schedule a 
Browse Bugs job.

Specify the date, time, and frequency of a 
Browse Bugs job.

Cancel a scheduled Browse Bugs job.

Select Resource Manager Essentials > 
Administration > Software 
Management > Schedule Browse Bugs 
Job.

Browse bugs by 
device.

Generate a summary of software image 
bugs for a group of devices.

Select Resource Manager Essentials > 
Software Management > Bug Report > 
Browse Bugs by Device.

Locate devices by 
bugs.

Search for known bugs that could affect 
the devices on your network.

Select Resource Manager Essentials > 
Software Management > Bug Report > 
Locate Devices by Bugs.

Update upgrade 
information.

Update the source for upgrade knowledge 
base files. The source can be either CCO 
or a local file.

Select Resource Manager Essentials > 
Administration > Software 
Management > Update Upgrade Info.

Table 2-13 Software Management Tasks (continued)

Task Purpose Action
2-30
Using Resource Manager Essentials

78-11544-02



Chapter 2 Resource Manager Essentials Applications
Syslog Analysis
Syslog Analysis
The Syslog Analysis application lets you centrally log and track system error 
messages, exceptions, and other information, such as device configuration 
changes. Use logged error message data to analyze router and network 
performance.

Before you can use Syslog Analysis, you must configure your routers and 
switches to forward messages either to the Essentials server directly or to a system 
on which you have installed a Syslog Analyzer collector.

The collector filters and forwards the messages to the Essentials server. Refer to 
the online help for information on configuring network devices for Syslog 
Analysis and for installing a remote Syslog Analyzer collector.

Table 2-14 shows the tasks you can accomplish with the Syslog Analysis 
application.

Table 2-14 Syslog Analysis Tasks

Task Purpose Action

Set up data 
storage 
options.

Configure how long to store data, the 
maximum number of messages to store, 
and the message source.

Be sure to restart your machine for the 
Message Source changes to take effect.

Select Resource Manager Essentials > 
Administration > Syslog Analysis > 
Change Storage Options.

Define custom 
reports.

Select the message types you want 
reported or change existing reports.

Modify the standard reports provided 
with Essentials or delete reports you no 
longer use. 

You can also enable 24-hour reporting.

Select Resource Manager Essentials > 
Administration > Syslog Analysis > 
Define Custom Reports.
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Syslog Analysis
Define 
automated 
actions.

Add and modify command-line 
instructions to be executed automatically 
whenever Syslog Analyzer receives a 
specific message type.

Modify existing actions and delete 
actions you no longer use.

You can also enable or disable actions.

Select Resource Manager Essentials > 
Administration > Syslog Analysis > 
Define Automated Action.

Define 
message filters.

Exclude messages you do not want 
reported. 

You can also enable or disable filtering.

Select Resource Manager Essentials > 
Administration > Syslog Analysis > 
Define Message Filter.

View status. View the status of your Syslog Collector.

You can view the status of the local and 
all the remote collectors that have been 
configured to use the Essentials server as 
the forwarding server.

Select Resource Manager Essentials > 
Administration > Syslog Analysis > 
Syslog Collector Status.

Change your 
URL.

Link your message reports to a 
customized web page. You can do this 
only if you know basic CGI 
programming.

Select Resource Manager Essentials > 
Administration > Syslog Analysis > 
Change User URL.

Generate a 
severity level 
summary.

Generate summaries of messages about 
selected devices sorted by severity level.

Select Resource Manager Essentials > 
Syslog Analysis > Severity Level 
Summary.

Generate a 
standard 
report.

Generate a system message report for a 
device or a set of devices. You can 
generate the report for the current date, or 
for any date in the previous week, or for 
all dates. You can include all the 
messages, or choose the severity level or 
alert type for which the report should be 
generated.

Select Resource Manager Essentials > 
Syslog Analysis > Standard Reports.

Table 2-14 Syslog Analysis Tasks (continued)

Task Purpose Action
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Syslog Analysis
Generate a 
custom report.

Generate a full custom syslog report. You 
can select a report from the custom syslog 
reports that are defined in Administration.

Select Resource Manager Essentials > 
Syslog Analysis > Custom Reports.

Generate a summary custom syslog 
report. You can see a summary of the 
various reports.

Select Resource Manager Essentials > 
Syslog Analysis > Custom Report 
Summary.

Generate a 
report for 
unmanaged 
devices.

Generate a syslog information report on 
all unmanaged devices in your network.

Select Resource Manager Essentials > 
Syslog Analysis > Unexpected Device 
Report.

Capture syslog 
messages.

Capture syslog messages generating from 
MCS servers running WF application.

Select Resource Manager Essentials > 
Syslog Analysis > WorkFlow Report.

Generate a 
24-hour syslog 
report.

Generate a report for the past 24 hours. 
The report can be a custom report created 
by a system administrator or a default 
report.

Select Resource Manager Essentials > 
24-Hour Reports > Syslog Messages.

Table 2-14 Syslog Analysis Tasks (continued)

Task Purpose Action
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